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FeatureCAM overview 

FeatureCAM is a CAD/CAM software suite that automates machining 
and minimizes programming times for parts on mills, lathes, and 
wire EDM. Unlike operations-based CAM systems, FeatureCAM 
generates toolpaths based on the features of the part, and 
automatically selects appropriate tools, determines roughing and 
finishing passes, and calculates feeds and speeds. The selections 
made can be based on the built-in machining knowledge that 
Delcam supplies 'out-of-the-box' with FeatureCAM, or from 
experience captured from your company, project or individual users' 
preferences. 

FeatureCAM includes five stand-alone modules: 
 2.5D Milling - 2.5D design and toolpath generation for 2- and 3-

axis mills.

 3D Milling - 3D surface modeling and 3-axis toolpath generation.

 3D Lite - a limited version of 3D milling.

3D Lite lets you mill only one surface per feature, but you 
can create multiple features. The strategies available in 3D 
Lite are Z-level rough, Parallel rough, Parallel finish, Isoline, 
and 2D spiral. 

 Turning - 2-axis design and toolpath generation for 2-axis lathes.

 Turn/Mill - Supports lathes with C and Y-axis milling capabilities.

 Wire EDM - 2- and 4-axis wire EDM toolpath creation.

The following add-on modules are also available: 

 RECOGNITION - 3D surface and solid import and the recognition
of 2.5D features from solid models. Accelerates making 2.5D and
turned parts from solid models.

 Tombstone - Multiple part manufacturing for horizontal or vertical
milling machines with indexers.
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 Solid Modeling - Solid modeling and tools for creating molds from
solid models.

 5-Axis Positioning - Manufacture 2.5D features from 5-axis
orientations.

 Native Import Modules - Native data can be read directly from
SolidWorks, SolidWorks Assemblies, Autodesk Inventor,
SolidEdge, Catia, NX, Pro-Engineer, and Step files.

 Machine Simulation - Modeling and simulation of a CNC machine.

 Advanced Turn/Mill (MTT) - Includes support for Turn/Mill in
addition to support for B-axis (5-axis positioning) and multiple
turret synchronization.

 Network Database and Licensing - Flexible product licensing allows
sharing FeatureCAM licenses across a network.

 5-Axis Simultaneous - Manufacture 3D features while changing
the tool axis.

Why creating toolpaths is so fast 
FeatureCAM has the unique ability to generate toolpaths and create 
NC code to run the machines with a minimum amount of user input. 

Traditional CAM systems are operations-based and require you to 
program every operation, one at a time, to create your part. 
FeatureCAM is feature-based; this means the part is created using 
features that describe that part, from simple holes, to complex 
pockets, to turned grooves. Machinable features contain information 
and rules describing how and where material removal should occur, 
cutting depths, whether to use climb cutting, whether to spot drill or 
center drill, and preferred machining strategies for roughing and 
finishing. This means that after you import or draw the part and 
identify its features, FeatureCAM automatically: 

 Selects the most appropriate tools and operations;

 Recommends machining strategies;

 Calculates speeds and feeds;

 Generates toolpaths and creates the NC code.

  You can customize this built-in 'intelligence' to your own style 
of cutting. 
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Intro to Turnmill Features 

Introduction 
 
FeatureTURNMILL allows the combination of turning and milling features on lathes with 
powered rotary tools. FeatureTURNMILL supports the normal Z and X axes of turning 
combined with the C and optional Y-axis. All turn/mill machining centers will support C axis 
(which the ability to rotate about Z). Y-axis is an option which adds to the cost of the 
machine. You should not assume that every turn/mill machine available will possess a Y-
axis.  
 
 

                           
 
The yoke shown in the left-hand figure could be manufactured with a C axis lathe in two 
setups or using a C axis lathe with a subspindle. The right hand figure is a piece that requires 
a Y-axis due to the flat pockets on the top and bottom of the piece. (If these pockets were 
wrapped, they would have a curved bottom and then they could be manufactured without a 
Y-axis.) 

Creating turnmill features in FeatureCAM 
 
Turn/mill features are classified as either Turn/Mill or pure Turning features. Turn/mill 
features assume powered tools and turning features assume that the tool does not spin. For 
example, you can make a hole along the Z-axis with both feature types, but the milled one 
uses rotary tools and the turned hole uses a drill that does not spin, therefore the spindle will 
spin instead. 
 

• Turning features are identical to those on a 2-axis lathe  
• Milling features are created the same as for a 3-axis mill, except that you are given 

new choices for positioning and orienting the features either on the OD or on the face 
of the part 
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In the screengrabs below you can see how after selecting Turn/Mill the software will allow 
the user to create milling features exactly like if he would be using our basic 2.5D module. 

         
 
All forms of simulation (Centerline, 2D, 3D and machine simulation) are supported. In 3D 
and machine simulation rotation of the part is accurately simulated, allowing the user to run 
toolpaths and experiment with different options using our simulation package instead of 
having to test different scenarios in the machine. 

Tool selection for turnmill features 
 
Turn/mill features use the same tools as the normal milling features, but they are renamed 
with –rotaryX or –rotaryZ appended to the name to indicate that it is a powered rotary tool. 
For example, if a tool called center_4 is selected for a turnmill center drill operation, the tool 
is copied and the copy is called center4-rotaryX. 
 
Rotary tools cannot be explicitly created, but if you manually select a tool for a turnmill 
operation, it is copied and the copy is designated as a rotary tool. Rotary tools cannot be used 
for turning operations. 

Features appropriate for turnmill 
 
Milling features can be performed in turnmill with the following considerations: 
 

• Milled features on the Z face: FeatureTURNMILL can make any feature on the face 
of a part by using only XZC moves, for machines that do not have a Y-axis. If you 
want to use Y-axis on the face of a feature, you must check the Cut using Y-axis 
coordinates check-box on the Dimensions page of the feature's Properties dialog  

• Drilled features on the Z face or OD can be created without any restrictions  
• Unwrapped milled features on the OD: These features are output in X, Y and Z 

moves.  
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o If your machine does not have a Y axis, the only features you can cut on the 
OD (without wrapping) is a simple slot whose length is aligned with the Z axis 

o If your machine has Y-axis capabilities, you can cut the full set of milling 
features on the OD 

• Wrapped features are supported (using a live tool), with known limitations - the 
same limitations that FeatureCAM has with wrapped 4-axis fetaures. To invoke 
wrapping, you must check the Wrap feature around Z-axis check-box on the 
Dimensions page of the feature's Properties dialog. 

Positioning features on the face of a part 
 
 
The picture to the right shows the stock like if we 
would be looking at it from a right-view. In the file 
there’s a star shape curve (red) that we will machine 
using a pocket routine.  
 
In our first turnmill exercise we will go through the 
necessary steps to create this feature and in the 
meantime cover basic principles that will help you 
understand why you would want to machine this 
with C or Y-axis. 
 
• Open the file Starshape.fm 
• You will need the Nakamura WT300 post for this project 
• Right-click on the screen and view the project in Isometric view. Notice 

that we have a star shape in the front of the part. We will make a pocket 
out of this shape 

• Go to New Feature, Turn/Mill, Pocket From Curve 
 

       
 
• Click on Next, pick the curve and continue through the wizard accepting all 

the defaults.  
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Notice that FeatureCAM will pick the machining angle based on the plane of the curve being 
selected. Every 2.5D feature (except simple groove) requires a planar curve. This plane 
determines the angle that the software will use to machine the feature. 
• Once you’re done with the wizard click on Finish and compare the values 

in the different field boxes are the same as the ones displayed in the 
screengrab below. Make sure that Cut feature using Y axis coordinates 
is not checked. 

 
 

• Run machine simulation. Note how in order to reach all the areas inside 
of the pocket the tool moves up and down along the X axis and the 
spindle rotates in C to position the stock. At the moment this part is being 
machined with X,Z and C 

 
If you decide to use 3D sim instead and you can’t see the spindle rotating when the 
simulation is running, go to Options, Simulation, 2D/3D Shaded and check the box Rotate 
view when indexing  
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• Now let’s open the properties of the feature and check the box Cut feature 
using Y axis coordinates so that FeatureCAM outputs and simulates Y-
axis moves to machine this part 

 

 
 
• Run machine simulation. Note how the spindle is now locked and the 

tool moves in X, Y and Z to reach all areas inside of this pocket 
 

 

Pros and cons of Y vs. C-axis  
 
Note: although we support both methods of machining, there are cases where the person 
using the software would favor one over the other. The chart below illustrates the benefits 
and detriments of both approaches. 
 
You (the user) can agree or disagree with the comments below. They are general to most 
machines and could not apply to your particular machine or shop background. Discussion 
with peer students is encouraged. 
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C-Axis Y-Axis 
Pros Cons Pros Cons 

Machines are cheaper 
w/o Y-axis option 

Surface quality 
suffers due to lack of 
Y and having to rely 
on C axis 

Achieves best surface 
finish based on XY 
moves. No C-axis 
involved during 
machining 

Expensive machines. 
Y-axis is usually 
found in upper turrets 
only  (if multiple 
turret machine) 

Less area limitations 
No constrains on Z-
face features 

Slower machining 
time. Most noticeable 
on older machines 

Faster machining 
time 

Limitation in the 
amount that the Y-
axis can travel 

Faster programming 
in some cases where 
repositioning would 
be needed with Y-
axis due to limited 
machining area 

Machining accuracy. 
If tool is not setup 
exactly on centerline 
of X-axis it could 
cause issues in 
features with parallel 
walls 

Due to no C-axis 
involvement, features 
are the most accurate. 
If a tool is not setup 
on center it can be 
corrected using offset 
values in the control 

Y-axis travel limits 
could require for a 
feature to be 
repositioned, causing 
possible witness 
marks and added 
programming time 

Handling Y-axis limits 
 
What is this limitation we talk about with Y-axis 
machines? These machines do not have unlimited 
travel for the Y-axis. The amount of travel is usually 
40-50mm in each Y direction, measured at X0. The 
furthest the tool travels in X, the less the Y-axis travel. 
The best way to understand Y-axis limits is to picture a 
diamond in the face of the part. You can obtain limits 
of your particular machine from your machine manual. 
Look at the picture to the right. 
 
 
 
 
 
 
 
 
So how do we cut a feature exceeding the machine Y-
axis? In the next picture you can see a 45 degree slot 
feature. In this case part of the slot lies outside of the 
Y-axis travel area. The following exercise will show 
us how to reposition a feature so that it can be 
machined within the Y-axis limit area. 
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• Open file Y-axis limits.fm 
• For this project you will need to use the Nakamura WT 300 post processor 
• Run machine simulation and notice how the software is currently 

machining the slot with C-axis. This is the perfect scenario for when you 
don’t want to use C-axis, as if the tool is not perfectly set on center of the 
X-axis, you could end up with a slight variation in the width of the feature 
 

If we don’t have a Y-axis machine this is the best we can do, but if we do (and our Nakamura 
machine does) then we want to use Y.  
 
• Open the feature properties and check the box Cut feature using Y axis 

coordinates so that FeatureCAM outputs and simulates Y-axis moves to 
machine this part 

• Run machine simulation. Notice how the slot is not being machined using 
X, Y and Z moves. The problem is that as we discussed, part of the slot 
area lies outside of the Y-axis limit boundary. How do we correct this? 
 

 
 

At the moment, FeatureCAM is not able to automatically detect when features are located 
outside of the Y-axis travel area. It is the user’s responsibility to understand how big this area 
is in their machine and to correct the toolpath so that it fits within those limits. 
 

 
• Open the feature and 

notice how the C Angle is 
set to 0 

 
 This means that FeatureCAM 
will use Y-axis to machine the 
part, but won’t shift the C-axis to 
reposition the part in a more 
appropriate orientation to reduce 
the amount of Y-axis travel. The 
feature will be machined in the 
same location where it is drawn. 



FeatureTURN  Intro to Turnmill Features 
 

 
8 Issue FeatureTURN 2012                                                                
  

• Enter 45 degrees, in the C Angle field, to make it match the angle of the 
slot 

 
 

By entering 45 degrees in the C Angle field the feature will be rotated 45 degrees while 
being machined, which means that it will be aligned with the X axis, causing the least 
amount of Y-axis travel. You can also pick an angle if you click on the C Angle word and 
then visually select a point in the graphics window. 
 
• Run machine simulation. Notice how the slot is not being machined using 

X, Y and Z moves but the feature is repositioned 45 degrees so that it fits 
within Y-axis limits 
 

 
 

This feature (C Angle) is not only useful for limiting Y-axis moves, it can also be used if the 
toolpath generated exceeds the X-axis travel. For example, if the groove would be positioned 
with an angle of 180 degrees.  
 
If you are ahead of the class and extra time, open file X-axis limits.fm and machine it using 
Y-axis in the X positive direction. 
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Positioning features about the OD of a part 
 
FeatureCAM also allows you to position features about the OD of a part. Just like features 
located on the face, they pay attention to the plane of the curve to determine the machining 
angle.  
 
The following exercise will go through the necessary steps to create a feature about the OD of 
a part. We will first make some features from curves and one from dimensions. 
 
• Open file Features about the OD.fm 
• You will need the Nakamura WT300 post for this project 
• Using the front curve, make a boss feature. Change the height to be 

2.000. Your feature properties should look like the screengrab below 
 

 
 

• Run machine simulation and notice how at the moment FeatureCAM 
picks a long tool to rough and finish the part. This is not the best approach 
to machine this feature, as a longer tool will cause chatter, take longer time 
to machine and have a shorter life 
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• Let’s borrow a feature from our 2.5D milling module!!! Go into the 
properties of the feature, click on Strategy and check the box Individual 
levels 

•  
 

This option will treat each z-increment as a separate operation, allowing the user to select 
different tooling for each pass. In this case, FeatureCAM will automatically select different 
tooling for us.  
 
• Run machine simulation once again. If you are using tool colors during 

simulation you should be able to distinguish fairly easily that we’re using 3 
different tools now to machine the same feature. Also notice how 
FeatureCAM picked the tools automatically depending on the z depth 
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• Make a pocket feature out of the circle on the OD of the part at 90 
degrees. Accept the default depth of 0.500. Note that FeatureCAM 
automatically determines the angle of the feature based on the geometry 
selected 

 
 

FeatureCAM will use the plane of the circle to determine the angle of the feature. Every 
plane has 2 possible Z directions. As a default, this direction will be calculated pointing 
towards the axis of rotation (Z in a turnmill document, stock axis in a 4-axis milling 
document). If you need to switch the direction you can do that easily in the Location tab of 
the feature using Cut feature from other side. 
 
• Make a pattern out of the last pocket feature created 
• Go to New Feature, Turn/Mill, Pattern from Feature. Make sure you 

select the appropriate feature you want to make a pattern out of (the 
circular pocket) 
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• Select Radial around the index axis and then enter 4 instances, 90 
degrees apart 

 
Notice how the options referring to the XY plane are disabled, as the orientation of the 
feature would not allow you to access that plane in a pattern 

       
 
• Your part should be looking like the picture below 

 

 
 
 
 
 
By now you get an idea of how features from curves are positioned based on the curve plane. 
Now let’s go ahead and make some features from dimensions to see what parameters need to 
be changed in order to position them in the correct location. 
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• Go to New Feature, Turn/Mill, Hole from Dimension. We will make some 
holes around the OD of the part. In order to reduce the number of steps 
needed to create the feature, also check the box Make a pattern from 
this feature. 

• In the Patterns page, select Radial around index axis 
 

       
 
• In the location tab enter a Radius of 1.6, an Angle of 45 and a Z location 

of -0.500.  
• In the Dimensions page, enter Number 4, Spacing Angle 90 
 

       
 
 
 
If you click on preview you should see how we’re positioning 4 holes, about the index axis, 
with a starting angle of 45 degrees, at a Z location of -0.500, repeated 4 times at 90 degree 
intervals. 
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• We will now make a linear pattern out of the radial pattern to repeat these 
holes 1 inch down in the Z direction 

• Go to New Feature, Turn/Mill, Pattern from feature 
• Select the pattern feature, click Next. Then Linear style, Next and repeat 

this pattern 2 times with a Spacing of 1 
 

       
 
• Your finished simulated part should look like this 

 

 
 
 

Extra challenge: if you are ahead of the class and are familiar with subspindle operations, 
transfer the part over to the subspindle and then create 2 flats 180 degrees apart on the other 
end of the stock. Cut one with Y-axis and one with C-axis 
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Synchronization Basics 

Introduction 
 
This exercise will go through the basic concepts of synchronization and how to achieve a 
faster running time on machines with multiple turrets. FeatureCAM can program anywhere 
from 1 to 4 turrets simultaneously. There is not a right or wrong answer when you do 
synchronization as long as simultaneous operations are capable of happening at the same 
time. When you are done with this file, your results should be similar to the picture below. 
 

 
 

 
 
• Click on File then Open.  Browse and open Synchronization basics.fm   
• Now, in order to select the right machine for the job, we need to use the 

right post (which contains information like number of turrets, b axis 
capabilities, etc). For this job we will use Naka WT-300 Fanuc18i w Sub & 
Y.CNC 
 
Note that this post is available from the partner area under the TM-lbry > dual units > 
Nakamura – Tome WT folder. By selecting this post, you are also making sure that the 
correct machine design file for simulation purposes is being selected.  

 
• We will make all turning features on this file. From the steps click on the 

new feature wizard, choose turning and press next.  Select from 
dimensions > face and press next.  Make sure the parameters in the 
page are correct and click on Finish.  
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• Now let’s make a hole feature on the face of the part to open up the ID. 
From the steps click on the new feature wizard, choose turning and 
press next.  Select from dimensions > hole and press next.  Make sure 
the parameters in the page are correct and click on Finish. You should 
enter a diameter of 1.75 and a depth of 4 (see screengrab below) 
 

 
 
 

 
• We’re ready to machine the OD now. From the steps click on the new 

feature wizard, choose turning and press next.  Select from curve > 
turn and press next.  From the following page select Curve Chaining. 

 
You will find that in this page we need to select a curve. Notice that we have no curves 
available, but FeatureCAM allows us to ‘Chain on the fly’.  You can click on the Curve 
chaining button and then pick the points on the screen to select the shape to be machined 
(this method shows extremely well when doing demos, as it allows for a continuous flow 
without having to stop the programming process to create curve) 
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• Create your curve from start to end picking on points following the 
geometry below 

  
 

• Click next and notice how feature create a 3D representation of the feature 
to be machined. Click on finish and run machine simulation of the part to 
see our toolpaths so far. You should see this: 
 

 
 

•  Following the same steps, make a Bore feature. Pay attention not to 
select part of the internal groove when you chain on the fly 

• Now we’re ready to machine the 2 grooves. We could create grooves from 
dimensions, however for this file, we will use the geometry already 
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available and make grooves from curves selecting the curves available in 
the document and using once again ‘chain on the fly’ 

 
 
• From the steps click on the new feature wizard, choose turning and 

press next.  Select from curve > groove and press next.  From the 
following page select Curve Chaining. 

 
• Notice that we only need to select 3 pieces of geometry – the 2 walls and 

the bottom diameter of the outside groove. Once you selected the 3 pieces, 
continue selecting next until you get to the dimensions page. In this page 
it is important that you select the correct orientation of the feature. In this 
case this is an OD feature, so we don’t need to change anything.  

 

 
 

• Now let’s follow the same steps and machine the inside groove feature. 
From the steps click on the new feature wizard, choose turning and 
press next.  Select from curve > groove and press next.  From the 
following page select Curve Chaining. 
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• Once you’ve chained your curve continue clicking next until you get to the 
dimensions page. Now pay attention to the location. You need to make 
sure that the location is ID for this groove.  

 
 

• Let’s run machine simulation and take a look at the final machined part 
 

 
 

Now, why do we need synchronization?? The part is finished, we didn’t gouge the part nor 
the machine, simulation looks good and toolpaths are fine. Well, if we look at this machine, 
you will notice that it has 2 turrets. At the moment, we’re only using one. Basically we use 
synchronization to cut parts faster. It is mathematics… 2 turrets are faster than 1. So, our first 
step will be to look at the machining time.  
 
• Run centerline sim, go to the details tab and look at the current time it 

takes to machine this file. My details tab looks like this (3:51). Your results 
could be different based on tool grade selected, material, max travel, etc. 



Advanced FeatureTURN  Synchronization Basics 

6 Issue Advanced FeatureTURN 2012  
 

 
 

• Now let’s analyze our tool usage. You will notice that whenever you select 
a post with multiple turrets 2 things will happen: 
 

o You will get another turret in the part view 

 
 

o You will get a new tab in the results window called turrets. 
Turrets is where you can see what operations are being assigned 
to each turret 
 

• Eject the simulation and click on turrets. Turrets has 2 view modes that 
you can select. Time based and operation based.  
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Time based offers a timeline that shows how long each operation takes. It is useful in 
the sense that you can visually check for operation time and adjust the order to 
accommodate for the shortest possible machining time. Operation based shows 
operations being displayed in columns. The operation based view is convenient for 
users, as it shows operations from top to bottom, just like NC code. It is a good idea to 
switch periodically while programming a part between these 2 modes in order to get 
the best of both worlds. 
 
• Let’s start by moving the drill operation (hole1 drill) to the lower turret. 

There’re multiple ways to achieve this: 
o By opening the feature at the operation level and switching from 

upper to lower turret 

 
 

o By right-clicking on the specific operation in the op list tab and 
selecting set opers to ‘Lower Turret’. Note that you can move 
multiple operations with this method if you pre-select them at the 
same time 

 
 

o By right-clicking on the operation in the turrets tab > Time view 
and selecting the appropriate choice 
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o By using the operation view and dragging the operation from its 
current turret to the desired one.  

 

              
 
 
Tips:  
• You can drag multiple operations in this page by holding the Ctrl key while selecting. 

This makes for much faster programming time as you don’t have to move operations 
individually.  

• If you make a mistake you can restore the previous ordering by moving the operation 
back to its original location or if you want to reset all operations you can right-click on 
the white area in the turrets tab and select the desired action (see below). 
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• Let’s try it. Left-click on the operation you want to move (hole1 drill) and 

then drag it to the lower turret. You should achieve the same results as in 
the screengrab above.  

• It is important noting that FeatureCAM will automatically select tooling that 
will apply to the current turret. For example, an operation using a SW tool 
in the upper turret will now use a NW tool in the lower turret 

• Also notice that you now get 2 warning signs next to the 2 operations 
happening simultaneously. This is not an error, but just a warning. If you 
hover over the operation with the mouse you will get an indication of what 
the warning is. Another way to see what the warning refers to is by clicking 
on the details tab and reading the warning message.  

• The warnings show because we have CSS (constant surface speed) 
turned on in one of the operations (face1 finish). However, the drill feature 
has a fixed speed. The machine would not be able to vary the speed for 
one operation and keep it constant for the other, so that’s why it is issuing 
a warning. We will cover how to fix this at a later time, but for now we have 
a bigger problem in our hands… Let’s run machine sim to see how things 
look so far. You should get a gouge like in the screengrab below 
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• The gouge happens because we have 2 operations designed to work on 

the face of the part. This is impossible to achieve at the same time, so we 
need to assign some priorities or ordering to them in order to keep the 
machine from crashing. We call this ordering process Synchronization. 
Synchronization is really easy to achieve in FeatureCAM. Just a matter of 
selecting operations and assigning ordering to them. Let’s give it a go. 
 

• Let’s first introduce the UI objects you will need to become familiar with. 
They are located on the upper right corner of the turrets tab and become 
available as you select operations in the UI (either in the time view or 
operation view). See screengrab below. From left to right, they perform the 
following functions: 

 
o Set sync point at operation start: which means that all selected 

operations will start together. In this case the order how we 
pick the operations is not important 

o Set one operation before the other: which means that the first 
operation selected will happen after the operation selected 
after. In this case it is very important to select the operations 
in the correct order 

o Remove all sync points: will remove all the synchronization 
points set in the file except for pinch or follow operations 
 

 
 

• Let’s try our first synchronization exercise: 
o Hold the Ctrl Key – we need to synchronize 2 operations, 

therefore we need to select multiple operations with the Ctrl key 
o Click on the operation face1 finish 
o Click on the operation hole1 drill 
o Click on the middle sync icon (one operation after the other) 

 
Another way to synchronize that will not be covered in this tutorial is to select the operations 
with the CTRL key and then (with the operations selected) right-click on them and select the 
appropriate synchronization option. Both methods are valid and work in the same manner. 
Just different ways to get to them. 
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• Now we have another possible issue. We need to make sure that the drill 

operation will be done before machining the OD with the turn1 rough pass1 
operation. Follow the steps above to make the hole1 drill happen before 
turn1 rough pass1. Your turrets tab should look like the picture below. 
Run machine simulation and see how the turrets now sit waiting for the 
next operation to happen. 
 

 
 

When you look at the turrets tab in the operation view mode you will notice that there’re little 
M and S distributed along the synchronization points and at the start of the program. They 
stand for main spindle and sub spindle and denote which turret has control of the spindle 
speed at the time. As a default FeatureCAM will assign control of the main spindle to the 
upper turret and the subspindle to the lower turret. In cases where there no operations in one 
of the turrets, the speed control will be passed to the turret performing the operation. 
 
If you are pinch turning or follow turning on the main spindle, the upper turret will have 
control of the speed. If you are pinch turning or follow turning in the subspindle, the lower 
turret will control the speed. 
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• Let’s now synchronize the operations so that we turn the OD and bore the 
ID at the same time and also add another sync point so that we turn the 
OD groove and ID groove at the same time.  

• First we will drag all 4 ID operations to the lower turret. To do this hold the 
Ctrl Key and select the 4 operations shown below. Then drag them to the 
lower turret 

            
 
 
• Now turn1 and bore1 will start simultaneously. The only thing we need to 

do here is to make groove1 and groove2 start at the same time. To do this 
Hold Ctrl and click on groove1 rough pass1 and groove2 rough pass1 
then click on the first sync icon (set sync point at operation start) 
 

 
 
• Let’s look at the time. Now… see how much time we can save by 

synchronizing features. Remember, previous time without synchronization 
was 3:51 
 

• Run centerline simulation and go to the details tab to look at the new 
time. Mine is now 1:56. So by synchronizing features, we save close to 2 
minutes per part! 
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You’re done!!!  Your simulation should look like this. There should be no 
gouges or collisions. 
 

 
 
 
 
 
Miscellaneous notes: 
 
• If you look at the turning operations you will notice that they have the warning signs 

regarding using CSS in different operations in different turrets at the same time. You can 
get rid of the warnings by switching to a fixed speed in every operation 

• You can shorten the length of the boring bars by opening the properties of the tool being 
used (in the feature itself or tool mapping) and changing the length of the boring bar or 
the exposed length 
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Hole synchronization 

Introduction 
 
This exercise will show you how to synchronize operations to achieve much faster machining 
time. It will focus in the process of having 2 turrets working in the same spindle at the same 
time with operations that can coexist with each other. 
In order to completely understand this tutorial it is critical for the user to be familiar with the 
previous module (101 – Synchronization basics) as this exercise will presume that you will 
already posses basic knowledge about some advanced turn/mill capabilities of the software. 

 

 
 
• Click on File then Open. Since we will be importing a different file type 

than *.fm, go to the bottom of the open dialog and select ‘Files of type: all 
files’. Go to the Data folder in MTT100 and open hole 
synchronization.x_t   

• Select a Turn/Mill document in inches 
• Align the part using the import wizard so that Z is pointing in the same 

direction as the picture below 
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• When it is time to resize the stock, enter the following parameters 

 
 

• Continue going through the wizard. Do not automatically recognize 
features when you get to that page. Although you could do this and finish 
the project much faster (good during a demo or when already familiar with 
the software), the purpose of this outline is to show you tips and tricks to 
improve your skills. Click Next 

• In the final page, select yes so that FeatureCAM creates geometry of the 
profile of the solid. Click on Finish 

 
When you click on preview you will get a blue profile of the geometry FeatureCAM will 
construct for you. Notice that the solid will be revolved about the Z axis and as a result the 
geometry being constructed will not go into the areas with the flats. This is especially useful 
when it is turn to program the turned features, as we won’t need to create extra geometry of 
the profile 

 
 

• Now, in order to select the right machine for the job, we need to use the 
right post (which contains information like number of turrets, b axis 
capabilities, etc). For this job we will use Naka WT-300 Fanuc18i w Sub & 
Y.CNC 
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Note that this post is available from the partner area under the TM-lbry > dual units > 
Nakamura – Tome WT folder. By selecting this post, you are also making sure that the 
correct machine design file for simulation purposes is being selected.  

 
• Before we start creating features we need to position the stock 

appropriately in the machine. This is very important as it affects the 
simulation and also the NC code 

• We need to tell the software how far is the face of the jaws (in the 
machine) in relationship with the setup we’re using to program the part.  

• Double-click on the setup go to edit and continue clicking next until you 
get to a page called Setup Simulation Information 

• If we look at the properties of the stock we will notice that its length is 5.8 
inches. Let’s say we want to grab the part by 1 inch, so the face of the jaws 
would be -4.8 from the setup. We need to enter -4.8 in the Z offset in the 
Setup Simulation Information page.  
 

 
 

Entering -4.8 in the Setup Simulation Information page causes the following outcome when 
simulating. Even though the length of the actual stock is 5.8 inches, only 4.8 are hanging out 
of the jaws of the machine. It is very useful to understand how this works because changing 
this number largely affects simulation and NC code generated. 
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• Now we’re ready to start programming features. From the steps click on 

the new feature wizard, choose turning and press next.  Select from 
dimensions > face and press next.  Make sure the parameters in the 
page are correct and click on Finish. Pay special attention to the Z 
location. If your setup is positioned in the face of the stock, you will need to 
adjust your Z location to be -0.050 as we added 0.050 when we went 
through the stock wizard 

 
 
 

• Now let’s do a hole feature on the face of the part to open up the ID. From 
the steps click on the new feature wizard, choose turning and press 
next.  Select from dimensions > hole and press next.  Make sure the 
parameters in the page are correct and click on Finish. You should enter a 
diameter of 1.75 and a depth of 3 (see screengrab below) 
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• We’re ready to machine the OD now. From the steps click on the new 

feature wizard, choose turning and press next.  Select from curve > 
turn and press next.  From the following page select Curve Chaining. 

 

 
 

• Create your curve from start to end picking on points following the 
geometry below. Once selected click on Finish 
 

 
 
 

• Let’s machine the ID now. From the steps click on the new feature 
wizard, choose turning and press next.  Select from curve > bore and 
press next.  From the following page select Curve Chaining 
 

• Create your curve from start to end picking the geometry below. Once 
selected click on Finish 
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• We’re now finished with the basic turning features. Let’s run machine 
simulation to see the part being machined up to this point 

• If you have gouge check turned on you will probably see a warning similar 
to the picture below. FeatureCAM detects a gouge when the boring bar 
collides with the body of the turret and pauses the simulation so that we 
can take action. Change the length of the boring bar and the drill 

 

 
 

There are multiple ways to fix this. The easiest one is to open the operations using the tools 
that gouge (in this case the drill and rough/finish of the bore) and edit the tool properties and 
adjust to a realistic length that will not cause a gouge. You can also do this in the tool 
manager page, but the drawback is that you have to look for the specific tool you are using 
and you probably have thousands of tools in there. It is much faster and easier to go to the 
particular operation and make the changes in there 
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• Let’s fix the drill first. Double-click on the tool being used and set the 
parameters like in the page below. Once done click OK and OK 
 

 
 
 

• Now it is turn for the bore. Open the tool properties and change the length 
to 7 and the exposed length to 4. Click OK and OK 
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• Let’s re-run machine simulation and see if we get any other collisions. You 

should not get any more warnings at this point. Also notice how the long 
boring bar now has a more realistic look to it and is not overhanging 
unnecessarily.  

 

 
 

In turning it is extremely important to keep all tools as short as possible when setting up jobs. 
Longer tools produce bad finish, break inserts, create chattering, and cause unnecessary large 
clearance amounts to avoid collisions. We also want to keep the turret as close as possible to 
the spindles to reduce retract moves and travel as much as possible. Less retracts and shorter 
tools equal faster machining time which is the reason why these machines are more and more 
popular every day. 

 
 

• Let’s now move to the turn/mill feature and machine the 4 flats. There’re 
several methods for machining the flats. We will cut the features using a 
combination of X and C axis moves.  

• From the steps click on the new feature wizard, choose turn/mill and 
press next.  Select from curve > side and check the box Extract with 
Feature RECOGNITION press next.   

• In the next page, we want to recognize features Along the setup Z axis. 
Select that option and press next 

• Here you have multiple methods to recognize the features. We will go 
through select side surfaces press next. You are welcome to select your 
own method if you are already familiar with other FeatureRECOGNITION 
options 

• Select the surfaces we want to machine (below in green) and add them to 
the list. You can hold down Ctrl if you want to select multiple surfaces at 
the same time and then click on the + sign to add them all together then 
click Next 
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• Continue going through the wizard verifying that the settings and values in 
the following pages are correct. Stop when you get to the New Feature –
Strategy page 

• Since we don’t have a lot of material to remove, uncheck the rough 
operations and just check the finish 

• When it is time to select tools use a 0.750 endmill 
 
As a default FeatureCAM will use the biggest diameter possible when creating toolpaths. 
Although we could use the biggest possible tool, usually turnmill machines and live heads 
don’t have a lot of torque, so it is better to select a smaller tool that can spin faster and 
provide better finish and not cause issues with the machine 
 
• Run machine simulation and see the progress so far. You will notice that 

the drill is probably now gouging when the end mill is machining the part. 
Ignore this warning, as we will eventually move the drill to the lower turret 
and the warning will disappear.  

 
If you decide you want to solve this gouge, you can do one of the following: 
• Edit the properties of the tool holder for the drill (select a shorter holder) 
• Use tool mapping to assign a different tool slot for the drill so that there will be no gouges 
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• Time to machine the 4 holes aligned with the Z axis. Go to the new 

feature wizard, select turnmill, hole from dimension and check the box 
Extract with Feature RECOGNITION 

• Click next, select Along the setup Z axis 
• Pick the 4 small holes in the face of the part. See screengrab below 
 

 
 
• Click on Finish, then open the properties of the hole feature, go to the 

strategy tab and uncheck the spotdrill as we are trying to save time and 
in this case we will not need to use a spotdrill. Click on OK 

 
Note that if you decide to use a spotdrill you will need to select a smaller tool size that will 
not gouge with the OD of the part. Practice this if you are ahead of the class, otherwise just 
uncheck it from the strategy tab 
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• Let’s do the holes around the front diameter of the part aligned with the X 

axis. Go to the new feature wizard, select turnmill, hole from dimension 
and check the box Extract with Feature RECOGNITION 

• Click next, select Around the index axis, check the Automatic box, next 
• Continue through the wizard, select all and finish 
 

            
 
• Run machine simulation and look at the finished part 
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• Now run centerline simulation again and look at the details tab to see 
how long it takes for you to machine this part. My details tab looks like this. 
It takes 7:15 to machine this part. Time to play with synchronization!!! 
 

 
• Notice that all operations are currently being assigned to the upper turret. 

The lower turret is just sitting there. Not being productive nor saving time 

             
 
Synchronization tips and tricks: 
• If you make a mistake while moving operations from one turret to another and you need 

to start from the beginning you can do a right-click on a white area in the turret tab and 
select the appropriate option 

o Reset all operations to default turret 
o Reset selected operations to default turret 
o Reset all oper sync points 

• Sometimes although you won’t see any sync points on the screen, operations still believe 
they are synchronized to other operations. This usually happens when the user mistakenly 
syncs the same operation to 2 different operations. In order to clear these errors it is 
recommended that you do a right-click and reset all operation sync points and start 
synchronizing from the start 

• If you select 2 operations and an option (like sync at the start or one before the other) but 
nothing happens when you set the sync point, this is due to the point above. Remove all 
operation sync points and you should be able to synchronize again 

• You can customize the turrets view to have different colors for operations happening in 
the main and subspindle. Different colors aid the user identify what’s happening in each 
spindle making simultaneous operations easier to identify 
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• It is a good idea to save your file before you start synching operations. The process of 
synchronizing operations can be quite complex and you might want to try different 
scenarios before you decide which one you like better 
 

• Move the following operations to the lower turret. If you wish, fix the 
length of the new tools selected (boring bar will be a different tool 
orientation, so it will probably be a longer tool again) 

o Hole1 drill 
o Bore1 rough and finish 

• Your turrets tab should look like the screengrab below. Assign the 
necessary sync points to achieve same results 
 

 
 

• New simulation should look like the picture below. If you run centerline 
and look at the details tab you should be already saving some time. At this 
point, my details tab reads 6:13, so I’m already saving a minute! Let’s save 
even more time 
 

 
 

• Move the following operations to the lower turret. To avoid the time it 
takes to do a tool change we will move the 4 holes in the Z axis to the 
lower turret so that once the upper finishes the 4 flats we can start 
machining holes. Assign necessary sync points to achieve same results 
as screengrab below 

o Hole2 drill (4 times) 
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• Run centerline and look at the details tab you should be already saving 

even more time. At this point, my details tab reads 5:19, so I’m already 
saving another minute!  

• Can we save more time? YES! 
 
If we look at the model you will find that the holes around the OD of the part are exactly 180 
degrees apart from each other. This particular machine has its turrets 180 degrees apart as 
well. So what if we attempt to drill one of the holes in the upper turret and at the same time 
also drill the opposing hole 180 degrees apart from it? Can we do this in FeatureCAM? Yes, 
we can! 
 
• Move the following operations to the lower turret. There’re 12 holes in this 

part. You should have 6 spotdrill and 6 drill operations in each turret. Make 
sure you move consecutive holes otherwise the holes will not be 180 
degrees apart.  
 

• Move: 
o Hole9 through 14 spotdrill (6 times – you can select them all 

holding the Ctrl Key and then drag the group) 
o Hole9 through 14 drill (6 times) 
o Set the necessary sync points like in the screengrab below  

 
Notice that although you could just sync the first 2 operations (hole3 spotdrill 
and hole9 spotdrill) and leave the rest without setting synchronization points, 
this is not a safe approach, as you need to be completely sure that every 
matching hole is finished before the spindle turns to machine the next hole.  
 
Not setting sync points for every set of matching holes could result in broken 
tools and damage to the machine and the part. For this exercise 
synchronize all matching operations at the operation start 
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Run centerline once again and look at the details tab. After the latest set of 
synchronization points my details tab reads 4:10. By using FeatureCAM’s 
synchronization capability I went from 7:15 to 4:10, saving over 3 minutes per 
part.  

 
• Final simulation results  
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5-axis Simultaneous 

Introduction 
There are two new strategies available for finishing using 5-axis simultaneous machining in 
FeatureCAM 2008.  These two new techniques are called 5-axis Trim and 5-axis swarf. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In 5-Axis Trim: 

• This strategy is used commonly in the mold industry where cast parts have a parting 
line edge that needs to be removed. 

• Tool will cut normal to selected machining surface with selected lead and lean angles 
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In 5-Axis Swarf:  
• Swarf Cutting calculates toolpaths which will cut with the side of the tool. 
• The side surfaces are selected and the side of the cutter will stay tangent to the surface 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Crankshaft Example 
In this example part we will cut a crankshaft using the 5-axis trim and swarf strategies.  
 
• Click on File then Open.  Browse and open CrankshaftTaper.fm   
• Click on Manufacturing -> Setups then press the edit button.  Press Next 

3 times and check “Always use this one” then browse for the machine 
design file named integrex200.md and press Finish and click Close. 

 
 To ensure this demo runs quickly change default graphics settings to: 

• Click on Options -> Surface Shading.  Make sure use graphics 
hardware is checked 

• Click on Options -> Simulation.  On the 2D/3D shaded tab make sure 
Metallic is unchecked and set Resolution to 4. 
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• Click on Manufacturing menu then choose Post Process.  Set the post 
processor to Mazak Integrex 200-IV S.cnc, located in the Data folder. 

• Change the tool location for X to 750 and 50 for Z, then click OK. 
 

 

 
 

• Click on the Manufacturing menu and choose Set Tool Crib, then select 
CrankshaftTaper.fm_Tools_from_last_save and click OK. 

 
• From the Steps click on the New Feature wizard, choose Turn/Mill and 

press Next.  Select Surface Milling and press Next.  Select the three part 
surfaces in the picture below and press Next. 

 

 
 
 

• Click Choose a single operation then press Next.  Select 5-Axis Trim 
and press Next 3 times, then select I want to search for another tool or 
make a new one and click Next. 

• Click the create new tool button  



                                            FeatureCAM Advanced Turnmill 

4 Issue Advanced FeatureTURN 2012  

• Enter the dimension of the new tool as shown below 
 

 
 

• Press OK, select Create a new tool and press OK. then click Yes to set 
the new tool as an override, then press Finish 

 
 
 
• In the Feature properties click on the trim op and then click on the 5-Axis 

tab.  Select Use Lead and Lean angle and set both to 0. 
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• On the Milling tab of the finish op click on Multiple Cuts, set the Leave 
Allowance to -5.5, Total stock to 15, Zincrement to 15 and then press 
OK 
 

 
 

• Drag the surface milling feature just created before ss1 in the Part View. 
 
• Run Machine Simulation and you should see the results as shown below. 
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• Create a new Surface Milling Feature and select the surfaces shown below 
on the tapered boss surface. 
 

 
 

• Press Next then select choose single operation press next then select 
Swarf.  Press Next 3 times, then select I want to search for another tool 
or make a new one and click Next. 

• Select the bull nose tool that was created in the previous surface milling 
feature and then press Finish and click OK. 

• Drag the surface milling feature just created before ss1. 
• Run a Machine simulation.  Results should look similar to those shown 

below 
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• Now the features are ready to be cut on the sub spindle.  In the Part View 
click on the Setup2 to make it active. 
 

• Click on Steps then New Feature wizard, select Turn/Mill then press 
Next.  Select Surface Milling then Next.  Select the three part surfaces in 
the picture below and press Next. 
 

 
• Click Choose single operation press Next.  Select 5-Axis Trim and press 

Next 4 times.  Select the 27 mm bull nose end mill created previously and 
press Finish 

• In the Feature properties click on the trim op and then click on the 5-axis 
tab.  Select Use Lead and Lean angle and set both to 0. 

• On the Milling tab of the finish op click on Multiple Cuts, set the Leave 
allowance to -5.5, Total stock to 15, Z increment to 15 and then press 
OK 
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• Run the machine simulation and you should see the results as shown 
below. 
 

 
 
 
 
• Create a new Surface Milling feature and select the surfaces shown below 

on the tapered boss surface. 
 

 
 
• Press Next and select Choose single operation, press Next and select 

Swarf.  Press next 4 times and select the bull nose tool that was created in 
a previous step then press Finish and click OK. 
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• Run the Machine simulation.  Results should look similar to below. 
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B-Axis Interactive Feature Recognition 
 
In this example we will be looking at various ways of identifying features from solids when 
using a B-Axis Turn/Mill. In previous versions of FeatureCAM it was necessary to create a 
setup with its Z axis aligned with the direction the tool would approach the feature before it 
could be recognized. It is now possible to identify features with multiple orientations in a 
single setup simply by selecting a surface whose normal is parallel to the direction that the 
tool would use to machine the feature. 
 
• Open the file B-Axis tutorial start.fm 
• Load the Mori Seiki NT4250.CNC file 
• Ensure that the post is set to use the matching MD file 
• Create a Turn feature from the curve curve1 using the default values 
• Create a Face feature using the default values 
 
Note that the Face feature is automatically ordered so that is before the turn feature. We will 
now machine the two angled faces on the end of the part. We will use IFR to identify the 
faces using their surface normals. 
 
• Take an Isometric view and Shade the model 
 
We are going to create a Face feature on the surface shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Open the New feature wizard 
• Under New Feature Type select a new Turn/Mill feature 
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• Click Next 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Check Face and Extract with FeatureRECOGNITION. 
• Click Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
At this point we have to specify the axis along which we are going to recognize features. We 
could use Specify angles and then explicitly enter the direction normal to the face but we 
would need to know both the indexing C angle and also the B angle of the head. With a face 
with a complex orientation it can be difficult to work out the angles required. However, if we 
use Normal to surface and then pick a face FeatureCAM will automatically work out the 
combination of C and B angles and find the face. 
 
• Check Normal to surface 
• Click on Next 
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• Click on the Pick surface button and then select face_510 
 

 
 
The Z axis for feature recognition has automatically been aligned with the normal of the 
surface. This is not a setup, it is a temporary axis that is just used for feature recognition and 
is then discarded afterwards.  
 
• Click Next 
• Click Add from selected items (the green plus on the upper left) 
• Click Next and Finish and then OK 
 

 
 

The face feature has been automatically recognised. 
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• Repeat the process to machine the face on the opposite side (face_511) 
 
As we are creating face features they are automatically ordered so that they are machined 
first. We actually want to do the initial facing operation, then the turning followed by the two 
angled faces.  
 
• In the Ops view drag the operations into the correct order as shown 
  

 
 
 
Next we will drill the holes on the face of the part; these can be identified using IFR along the 
setup Z axis. 
 
• Create a new Turn/Mill feature 
• Select Hole and Extract using FeatureRECOGNITION 
• Click Next and select Along the setup Z axis 
• Click Next twice until you reach the Hole recognition options page 
• Click Select all and then Finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You should now have three holes on the front face of the part. We will now machine the two 
pockets on the angled faces. 
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• Open the New feature wizard 
• Under New Feature Type select a new Turn/Mill feature 
• Click Next 
• Check From curve - Pocket and Extract with FeatureRECOGNITION 
• Click Next 
• Check Around index axis 
• Check Normal to surface 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click on the Pick surface button and then select face_510 
• Click on Next 
• Select Automatic recognition 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click on Next 
• Click Select all 
• Click Finish 
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You should now see a pocket feature as shown above holes on the angled face using IFR. 
 
• Repeat the procedure to machine the pocket on the opposite face using 
face_511 to identify the Z direction for feature recognition 
 
Next we will machine the 4 curved side features on the upper and lower sides of the part. As 
these are in a simple orientation (C 0 and C1800 we can use a specified index angle for 
recognition.  
 
• Open the New feature wizard 
• Under New Feature Type select a new Turn/Mill feature 
• Click Next 
• Check From curve - Side and Extract with FeatureRECOGNITION 
• Click Finish 
• Check Around index axis 
• Check Specify Angles and set 0 and 90 as shown 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Next 
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• Check Automatic recognition 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The two side features have been recognized. We just need to select them to lock them in. 
 

 
 
• Click Select all and then Finish 
• Repeat for the opposite face (index angle 180) 
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We will now recognize the remaining holes which are not aligned with the setup Z axis. 
 
• Open the New feature wizard 
• Under New Feature Type select a new Turn/Mill feature 
• Click Next 
• Check Hole and Extract with FeatureRECOGNITION 
• Click Finish. 
• Check Around index axis and Automatic 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Next 
• Check Exclude holes… and set the diameter to 0.3in. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Next 
• Click Select all 
• Click Finish 
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We will now make a side feature to machine the hexagon. 
 
• Open the New feature wizard 
• Under New Feature Type select a new Turn/Mill feature 
• Click Next 
• Check Side and Extract with FeatureRECOGNITION 
• Click Next 
• Check Along setup Z axis 
• Click Next 
• Check Automatic recognition 
• Click Next 
• Click Select all and then click on the round side feature to deselect it 
• Click Finish 
 
Finally we will make the pattern of pockets on the faces of the hexagon.  
 
• Open the New feature wizard 
• Under New Feature Type select a new Turn/Mill feature 
• Click Next 
• Check From curve - Pocket and Extract with FeatureRECOGNITION 
• Click Finish 
• Check Around index axis 
• Check Normal to surface 
• Click on the Pick surface button and then select face_395 
 

 
 
 
• Click Next 
• Select Automatic recognition 
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• Click Select all and then Finish 
• Open the New feature wizard 
• Under New Feature Type select a new Turn/Mill feature 
• Click Next 
• Select Pattern and click Next 
• Make sure that pocket3 is selected then click Next 
• Check Radial about the index axis and click Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Enter a Number of 6 and a Spacing angle of 60 degrees 
 

 
 
• Click Finish 
• Run a Machine simulation to see the results 
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B-Axis Chamfers 

Introduction 
 
This chapter will take you through the necessary steps to orient a single tool so that it can cut 
several features that would require multiple tool changes and different tool orientations. This 
is especially handy for B-axis machines, since tool changes can take a long time and the 
programmer needs to maximize tool utilization in order to reduce cycle time.  

 

         
 
 
 
• Open file B-axis chamfers.fm 
• For this tutorial we will use the Mori NT4250.cnc post file 
 
This file uses a solid model as a stock. The solid model has no chamfers on the corners, but 
we’ve created some geometry that we will use while creating features. In a non-B-axis 
machine you would have to pick 3 different tools to machine the chamfers (they all require 
different tool orientations). Can we do this with just one tool? Stay tuned…  

 
• Start by creating our first turning feature 

for the OD chamfer in front of the part. 
Go to New Feature, click on Turning, 
then Turn from Curve 

 
When prompted to select a curve, pick the line 
segment highlighted in picture to the right.  
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• In the Strategy tab, uncheck the rough operation and make sure that the 
Finish direction is set to Negative 
 

 
 

• Let’s make another Turn. In this case, pick the OD chamfer in the back of 
the part. In the strategy tab, select Back Face. Like with the previous 
feature, uncheck the rough, set the direction to Negative 
 

    
 
• Let’s now cut the last chamfer in the ID of the part. Create a Bore feature, 

set the cycle to Bore, uncheck the rough and set the direction to 
Negative 

 
For this feature you could also select a Turn > Face or a Turn > Turn approach. Some of these 
strategies will require you to enter additional parameters into the software (change engage 
angle, different tool orientations, etc). We are creating the outlined features so that we can 
show you benefits of using the B-axis orientation control. 
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• Now run Machine simulation and notice how the software picks 3 tools to 

machine the 3 features, as every feature requires a different tool 
orientation 
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
With a non-B-axis machine you would have no other choice than to use 3 tools. The problem 
with this is that you have to go through a tool change after every feature, adding to your total 
machining time. With a B-axis machine, although you would still retract after every 
operation, you don’t have to pick a different tool (carrousel or index turret). You just re-
orient the B-axis and move on. 

 
• So, let’s pick just one tool for all operations. Go to the first turn feature 

and, click on the finish operation and then on the Tools tab 
• Filter tools by Insert Shape and select a SW_Turn_35 degree diamond 
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• Once we’ve assigned the tool we would like to use for all operations, let’s 
override ALL operations to use the same tool. There’re multiple ways to do 
this. The easiest one is to do it in the Op list 

 
o Select the first operation 
o Hold Shift Key and select the last operation 
o Right-click on the last operation 
o Select Override with SW_Turn35 
o Click on Yes when you get the warning about overriding 

operations with the same tool 
 

 
 
 

1 

2 

3 
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• Now go to the tool properties tab of the second turn feature and notice 
how FeatureCAM automatically rotated the tool 180 degrees about its 
axis so that it can achieve the necessary orientation for the feature 

 

 
 

So how do we do this? Can we manually control this rotation if we want to? The answer is 
yes. When you select a B-axis post, FeatureCAM will activate a new icon in your Tools tab. 
The Set B-axis tool orientation icon 
 

 
 
There are 3 available options within the dialog: 

• OD Turning tool: allows the user to set a tool as a SE or SW (NE or NW if lower 
turret) 

• ID Boring Bar: allows the user to select a boring bar approach angle (ES, EN, WS, 
WN) 

• Neutral: allows the user to enter angles for the tools 
o B-axis angle: head angle 
o Tool rotation angle: to rotate the tool about the center axis (i.e. this would 

make a SE tool out of a SW tool) 
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If you click on the Set B-axis tool orientation icon in this feature, you will see that 
FeatureCAM automatically rotated the tool from SW to SE so that it could be used for the 
Back Face turning feature 

 
• Now go to the tool properties tab of the last turn feature. Click on the Set 

B-axis tool orientation button and set the tool as an ID Boring Bar with a  
WN angle 
 

 
 

Click OK, Apply and OK again. Your final simulation results should be 
similar to the picture below 

 

. 
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Turn/Mill Demonstration 

Introduction 
This demonstration is intended to give the customer an overview of FeatureCAM Turn/Mill.  

 
Before the Demonstration 
 
• Open the Turn/Mill document Demo Start.fm 
• Select the Tools tool crib. 
• From Options > Addins select the addin subspindle.bas 
• Make sure that the Mori Seiki NT 4250 post has been selected. 
• Double click Setup1, click Edit. 
• Click Next until you reach the Simulation  information page. 
• Check that the corresponding MTD file is selected. 
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Start of Demonstration 
 
• Select a Top view and shade the part. 
 
 

 

 

 

 

 

 

 

 

 

 

The stock, part and setup should appear as above. 

The first two features are to be a facing operation followed by a drilling operation. 

• Create a new Turning feature. 
• Check Face and click next to the Location form. 
• Set the location to Z - 0.05. 
• Hide all then show all solids. 
• Select and isometric view and pick the inside surface of the hole. 
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• Create a new Turn/mill feature. 
• Check Hole and Extract with feature recognition then click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Check Along setup Z axis and click Next. 
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• Fill in the form as below and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Select all and then Finish and OK. 
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We will now extract the turning profile from the model. 

• Open the Curve wizard. 
• Check Curve from surface and Revolved boundary then click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Check Surface method, All surfaces and Convert to geometry. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Finish. 
• Hide all. 
• Show all geometry. 
• Select a Top view. 
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The extracted geometry should appear as below. We are now ready to make a turning feature 
to rough and finish the profile of the part. This operation will cut half of the profile. The other 
half will be cut on the sub-spindle later. 

 

 

 

 

 

 

• Create a new Turning feature. 
• Select Turn and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Curve chaining. 
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• Click on the geometry at the points indicated to generate a curve. 
Point 1    Point 2 

 
• Click Next then Finish and OK. 
 
The turning feature should appear as below. 
 

 
 
 
• Select an Isometric view. 
• Run a 3D simulation. 
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The turned part should now look like this. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Eject the simulation. 
• Hide all and Show all Solids. 
 
We will now mill out the pocket areas highlighted below. 
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• Create a new Turn/Mill feature. 
• Check Pocket and Extract with feature recognition then click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Check Around the index axis and enter an Index angle of 90 degrees. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Preview. 
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• Select an Isometric view. You should see the pocket pointing upwards 
with the Z axis aligned as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Check Use horizontal surface and select the two surfaces indicated. 
 

 
 
• Click Next. 
• Click the Green plus to add the faces to the selection then Finish & OK. 
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Note how the pocket depth has been set by the height of the side surface picked. In this case 
we will have a heavy first cut but reduced air cutting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
There is an identical pocket on the opposite side of the part. A pattern will be created from 
the existing pocket feature to cut the two pockets in a single operation. 
 
• Create a new Turn/Mill feature. 
• Check Pattern and click Next. 
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The feature pocket1 should already be selected. If not select it and click the green plus. 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Next. 
• Check Radial around index axis and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Enter the values shown below and click Finish and OK. 
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The lower part of the pocket will now be machined, as this has no bottom it will be created as 
a side feature using automatic recognition. 
 
• Create a new Turn/Mill feature. 
• Check Side and Extract with feature recognition. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Next. 
• Check Around the index axis and enter an Index angle of 90 degrees. 
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• Click Next. 
• Check Automatic recognition then click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Select all and then Finish and OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As before a pattern will be created from the side feature to machine both sides of the part in a 
single operation. 
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• Create a new Turn/Mill feature. 
• Check Pattern and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The feature side1 should already be selected. If not select it and click the green plus. 
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• Click Next. 
• Check Radial around index axis and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Enter the values shown below and click Finish and OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select an Isometric view and run a 3D simulation. 
• Select a Top view, note the the pocket sides have been cut vertical.  
 
We shall now add a swarf machining operation to add the draft to the pocket sides. 
A swarf milling operation is a multi-axis process that cuts a wall with the side of the cutter. 
The cutter is automatically tilted to maintain contact with the wall. 
 
• Eject the simulation. 
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• Create a new Turn/Mill feature. 
• Check Surface Milling and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Shift select the faces making the side of the pocket and click the green 

plus to add them to the list. 
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• Click Next. 
• Check Choose a single operation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Check Swarf and click Next. 
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• Click Next to the Default tool page. 
• Check I want to search for another tool then click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select a 12mm long reach flat end mill. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Finish. 
 
 



                                                                      FeatureTurn/Mill 

20 Issue FeatureTurn/Mill 2012  

• Select Check surfaces from the Dimensions tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select the bottom face of the pocket and click the green plus. 
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• Click OK and Apply. 
• Select the Swarf operation. 
• Select the Tool axis tab and check Reverse tool axis. 
 

 
 
• Click Apply and then OK. 
• Create a swarf feature on the other side of the part using the method 

described above.  Run a 3D simulation to show how the tool axis tilts 
during the swarf machining operation. 

 
One half of the part is now completed. We need to pass the part over to the sub-spindle to 
machine the other end. 
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• Create a new Turning feature. 
• Check User and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select SubSpindle UDF and click Next. 
 
 
 
 
 
 
 
 
 
 
• Set Multi Turret = No and Transfer type = Slug transfer. 
• Click Finish. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



FeatureTurn/Mill                                                               

                                                                          
Issue FeatureTurn/Mill 2012                                                                              23 

• Double click on setup1 to open it’s properties. 
• Click New. 
 
 
 
 
 
 
 
 
 
 
 
 
• Check Turning and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Check Align to stock face then click Next. 
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• Click the Left hand button and then click Finish. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The new setup and the part should now be aligned as shown below. 
 

 
 
• Create a new Turning face feature at Z -0.05  
• Hide all. 
• Show all geometry. 
• Select the Top View. 
• Create a new Turning Feature. 
• Check Turn & click Next. 
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• Click Chain Curves. 
• Select the geometry at the points indicated to create the curve. 

Point 1   Point 2 
 

 
• Click Finish and then OK. 
 

The new turning feature should now appear as below. 
 

 
 
We will now create a hole as a starting point for the large bore in the left hand end of the part. 
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• Create a new Turn/Mill feature. 
• Check Hole, uncheck Extract with FeatureRECOGNITION & click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Fill in the form as shown and click Finish. 
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• Click on the Drill operation and select the Tools tab. 
• Select Twist drills. 
• Scroll down the tool list to the bottom and select a 38mm drill. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click New tool. 
• Fill in the form as shown below, click Apply and then OK. 
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• Click Yes to set the new tool as the override. 
• Hide all. 
• Show all geometry. 
• Select the Top View. 
• Create a new Turning feature. 
• Check Bore then click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Chain Curves. 
• Select the geometry at the points indicated to create the curve. 
 

Point 1   Point 2 
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• Click Finish and then Preview the feature 
 
Note how the roughing starts at the centre. As the hole has been pre-drilled this is 
unnecessary. 
 
• Select the rough operation. 
• Select Min radius boundary. 
• Click on the arrow 

•  Select this point on the bore. 
• Click Apply and then OK. 
 
We will now finish the scalloped edge of the part using a swarf machining operation. 
 
• Hide all and then Show all solids. 
• Select a Top view and box select the surfaces highlighted below. 
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• Rotate the view and deselect the surfaces indicated below. 
 

 
 
 
• Create a new Turn/Mill feature. 
• Check Surface Milling and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click on the green plus to add the selected faces to the feature. 
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• Click Next. 
• Check Choose a single operation. 
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• Check Swarf and click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Next to the Default tool page. 
• Check I want to search for another tool then click Next. 
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• Select a 12mm long reach flat end mill. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Finish. 
• Select the finish 1 operation then the Milling tab. 
• Set the Axial offset to - 0.05. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The axial offset will ensure that the end of the tool goes past the bottom of the swarf feature. 
 
• Click Preview. 
• Simulate the swarf feature. 
• Eject the simulation. 
• Click OK. 
• Click in the graphics window to deselect all faces. 
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The final operation is to drill and counterbore the holes on the conical section of the part. 
These holes will be created using Automatic Feature Recognition. 
 
• Create a new Turn/Mill feature. 
• Check Hole and Extract with FeatureRECOGNITION. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Next. 
• Check Around the index axis and Automatic. 
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• Click Next. 
• Check that the form is filled in as below then click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
FeatureCAM will now use it’s Automatic Feature Recognition to find the holes. 
The holes in the part should appear as below. 
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• Click Select all and then Finish. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Run a 3D simulation using Simulate to next operation until the part is 

transferred to the sub spindle then Play. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The part is now finished. 
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Multi-Turret Synchronization 
 
In this document, we will be looking at reducing the machining time for a turn/mill part by 
synchronizing the motions of the turrets. The part we will be working on already has all of 
the features defined. The machine we are using will be a Mori Seiki NZ which has three 
turrets. What we will be doing is to use these three turrets on the machine to cut features 
simultaneously. By doing more than one operation at a time, we can greatly reduce the 
overall time taken to finish the part.  
 
The machine has two upper turrets and one lower. The upper turrets work on individual 
spindles only, the lower turret can work on (address) both the main and the sub spindles. 
 

 
 
 The above image shows the machine with the main body removed. The main spindle is on 
the left, the sub on the right. The turret on the upper left is the main turret upper spindle. The 
one to the upper right is the sub spindle upper turret. These two turrets can only work on the 
part when it is being held by the relevant spindle. The turret at the lower right can work on 
either spindle. 
 
If you want to check which turrets can address which spindle for a particular post, you will 
find this information by opening the post in XBUILD and going to CNC Info > Turrets. 
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First of all, we will open the FM file and load the matching post and .md file. 
 
• Open the file 3 turret synchronization start.fm 
• From the same directory load the Mori Seiki NZ.CNC file 
• Pick the crib 3 turret synchronization start.fm_Tools from last save 
• Run a machine simulation 
 
Notice how the operations happen sequentially; the part is first machined on the main spindle 
and then handed off to the sub spindle for the second series of operations. All of the 
operations are happening on the upper turrets at the moment.  
 
• Eject the simulation 
• In the Results window click on the Turrets View (last tab lower right) 
 
There are two options here: we can select either the Time View or the Operation View. 
 
• Select Time View 
 

 
 
The Time view shows each of the operations along a time line from left to right. The length 
of each operation is shown graphically as a distance along the time line. In the image above, 
you can see that the main spindle operations are shown as a group above those on the sub 
spindle. In each case, the operations are shown on the relevant turret. When there are many 
operations, it may be difficult to see the names of each operation. The time line scale can be 
expanded or reduced by using the middle mouse scroll key to enable the names of shorter 
operations to be seen. The scale along the top indicates the time in minutes taken for each 
operation. As the operations are shown sequentially, the overall time can be seen by going to 
the end of the time line or by looking at the Total Time figure which is shown at the lower 
left of the image above. In this case the time is 9 minutes and 4 seconds. 
 
We will now look at the operation view. 
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• Select Operation View 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The view now shows the operations as three columns - one for each turret. In this case, the 
length of each operation is not represented graphically. The operations are ordered from top 
to bottom; that is, the first operation in each column is going to happen before the second. At 
the moment, there is no synchronization, so the turrets are working independently of each 
other. Notice that there are no operations assigned to the lower turret. We will now start to 
synchronize the motions of the turrets so that more than one operation happens at a time. 
  
• From the View menu Hide All 
• Now Show All Solids 
• Click down each of the features in the in turn to familiarise yourself with the 
location of each one. You will notice that the holes have been individually 
named so that their positions can easily be located. 
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The first change that we will make will be to change the rough and finish turning operations 
on the main spindle to use Pinch Turning. What this will do is to use both the upper and 
lower turrets on the main spindle simultaneously to turn the OD of the part. As we will be 
using two diametrically opposed tools, we can effectively increase the feedrate by a factor of 
two and cut the time in half. This is an example of automatic synchronization; FeatureCAM 
will set the synchronization points without any manual intervention on our part. 
 
• Double click on the operation Turn1 to open its properties 
• Select the Strategy tab 
• Set both the rough and finish operations to be pinch turning 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Apply 
 
You will see that FeatureCAM has not found tools for the new operations that are on the 
lower turret. This is because the “Tools from last save” were all upper turret tools so there are 
no tools available with the necessary orientation to work off the lower turret. 
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• Change the tool crib to Tools 
 
Now that there are lower turret tools available the warnings disappear. As the tools in the 
original crib all had overrides their selection is not changed. 
 
• Click OK and check the Turrets View 
 

 
 
Now you can see that there are two new operations on the lower turret on the main spindle 
side. The horizontal red lines mean that the operations are synchronized at their start. The 
small M and S icons indicate which turret is going to be controlling the feedrate for a 
particular operation. This is important where using constant surface speed (CSS) in a turning 
operation as the distance of a tool from the center of the part will be controlling how fast the 
spindle is turning.  
 
• Preview the operation turn1 
• Single step a centerline simulation 

 
 
 
 
Note how the two tools are now moving in 
synchronization with each other. Both the 
upper and lower turrets are working 
together to clear the material from the 
part. The black dots that appear at the 
beginning of each pass are Wait Codes. 
That is the post processor will issue a code 
that tells the machine tool controller that it 
should not start the next operation until 
the last one has finished and both turrets 
are ready in position to start the next pass. 
 

• Turn all of the operations back on 
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• Run a centreline simulation 
• Select the Time View 
 

 
 
Note that on the Main Spindle timeline we are now using both the upper and lower turrets for 
the rough and finish turn operations. The Total Time figure is now 8 minutes and 25 seconds, 
a saving of 39 seconds.  
 
We will now look at manually synchronizing some of the drilling operations on the main 
spindle. We will use both the upper and lower turrets to drill the OD holes simultaneously. 
The first thing to do is to allocate which hole is to be machine from which turret. We will 
allocate half of the OD holes to the upper turret on the main spindle and the remainder to the 
lower turret. 
 
• Select the OD holes indicated below (180 through 330). Use the control 
key to multiple select the holes. 

 
 
 
 
We are selecting these Spotdrill operation on the OD so that 
we can move them over on to the lower turret. We will then 
need to pair them up with their opposing holes on the upper 
spindle so that they can be drilled simultaneously. 
 
 
 
 
 
 
 
 
• Holding down the control key drag and drop 
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the operations into the center column, this will move the operations onto the 
lower turret 
 

 
 
Note the red exclamation marks indicating a warning. In this case the problem is that the 
current timings mean that we are trying to carry out turning and milling operations at the 
same time, obviously this is not possible. We now need to manually reorder the operations so 
that they happen in a sensible sequence. 
 
• Control select the OD holes on the lower turret and then drag and drop 
them below the turn1 finish Turret 2 operation as shown below 
 

 
 
We can now start matching up the upper and lower turret motions for opposing holes. We 
will be first matching od_hole_0 spotdrill with od_hole_180 spotdrill. 
 
 
 
 



                                                                               
FeatureTURN/MILL 

8 Issue FeatureTURN/MILL 2012  

• Click on od_hole_0 spotdrill 
• Hold down the control key and click on od_hole_180 spotdrill 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Right click on od_hole_0 spotdrill 
• Select Set synch point at operation start 
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The operations od_hole_0 spotdrill and od_hole_180 spotdrill are now synchronized. Note 
the warnings against the other holes. This is because they are not synchronized. As the holes 
are different depths they will take different times to machine. This will result in the hole 
drilling operations getting out of synch so that when one is finished it is not ready to start the 
next opposing pair of holes.  
 
• Select the Time View 
 
You can see this problem clearly in the time view. Note how the first two spotdrill operations 
start simultaneously but end at different times. As each operation follows on they get 
gradually more and more out of step.  
 

 
 
We need to match all of these spotdrill operations in pairs. This will introduce Wait Codes 
into the program. A wait code which will not allow the machine to move onto the next 
operation until the previous one on the opposing spindle is completely finished.  
 
• Click on od_hole_30 spotdrill 
• Hold down the control key and click on od_hole_210 spotdrill 
• Right click on od_hole_30 spotdrill 
• Select Set synch point at operation start 
• Repeat for the other OD spotdrill operations until they are all matched as 
shown below, (60-240, 90-270, 120-300 and 150-330) 
 
 
 
 
 
 
 
 
 

Note how all of the warnings have now disappeared. 
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• Switch to the Time View 
 

 
 
Note how the spotdrill operation on the upper turret takes a shorter time than that on the 
lower. By synchronizing the operations we are forcing the upper turret to wait until the lower 
has finished. They then move on together to the next pair of holes.  
  
• Repeat the synchronization process for the operations od_hole_0 drill 
through od_hole_330 drill matching 30-210, 60-240, 90-270, 120-300 and 
150-330. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Run a Machine simulation 
 
You will see that the two turrets work together, if one finishes before the other it waits and 
then the two drills move on simultaneously to start the next drilling operation. Note, if you 
get a collision it may be necessary to change the tool mapping on the lower turret. 
 
• Select the Time View 
 
You will see that the Total Time for the part is now down to 7 minutes and 23 seconds, a 
saving of 1 minute and 41 seconds over the original operation sequence. 
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We will now work on the operations on the sub-spindle. We will change the turn operation to 
be Pinch so that we use the sub-spindle upper turret and the lower turret simultaneously. In 
order for this to work we need to move the turn2 operation to a position in the operation 
ordering where the lower turret has finished working on the main spindle operations and 
becomes available to work on the sub-spindle. We can change the operation order in several 
ways; in this case we are going to move them in the operations list. 
 
• Go to the Ops list tab 
• Select the two operations that make up turn2 
• Drag and drop them to the end of the program 
 

 
 

 
 
• Go back to the Turrets tab Operations view 

We now need to add a synchronization point so that the turn2 rough pass 1 operation 
happens after the od_hole_330 drill. This will introduce a wait code so that the sub-spindle 
will machine the face & pocket operations using the sub-spindle upper turret and then stop 
until the lower turret has finished all of the drilling operations.  
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• Hold down the control key and left click on od_hole_330 drill 
• Hold down the control key and left click on turn2 rough pass 1 
 

 
 
• Click on the icon indicated to place the operations in the correct order 
 

 
 
The order in which you select the operations is important. They will be reordered in the order 
that you selected them. This is why we selected the feature  od_hole_330 drill before  
turn2 rough pass 1. Note that as the operations turn2 rough pass 1 and turn2 finish are 
part of the same operation they will be moved together even though we only selected one. 
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We will now change the rough and finish operations in turn2 so that pinch turning is used.  
 
• Double click on the operation Turn1 to open its properties 
• Select the Strategy tab 
• Set both the rough and finish operations to be pinch turning 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Apply and then OK 

 
 
 
 
 
 
 
 

• Go to the Time View 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Total Time is now down to 4 minutes and 20 seconds from the original 9 minutes and 4 
seconds giving a total saving of 4 minutes 44 seconds or approximately 52%. 
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